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Safety Rules and Issues 
 

 Warnings  
Read the ENTIRE Owner’s Manual before operating!  Updates to this manual can 
be found at http://www.iupcorp.com/iupcorp/downloads.htm. 
 
Failure to follow all instructions may result in electric shock, fire, serious injury or 
death.  Save these instructions with the Fault Wizard for reference by all operators. 
 
Follow all local, State, Federal (Country) laws and codes that govern working with 
High Voltage equipment such as the Fault Wizard.  It is highly recommended that a 
formal Standard Operating Procedure (SOP) be established for the use of the Fault 
Wizard in your specific environment following all government regulations and your 
internal company rules and regulations for such use. 

 
Danger- HIGH VOLTAGE delivered at output connectors! The Fault Wizard 
produces a high-voltage electrical discharge that is potentially LETHAL.  Only 
personnel trained in the safe handling and operation of high voltage electrical 
devices should use this device.  Do not allow persons unfamiliar with the Fault 
Wizard to operate. 
  
Wearing properly rated high-voltage electrical gloves is mandatory while operating 
this device! 
 
Inspect output cables before use.  DO NOT USE if damaged insulation is present. 
 
DO NOT USE if the control panel or blue case is cracked or contains holes that will 
allow potentially combustible material inside the unit such as coal dust.  Use of the 
unit under such conditions could lead to an EXPLOSIVE situation!!! 
 
This device creates sparks.  Therefore, for environments where explosive or 
combustible gas is possible, gas checks should be performed before, during, and 
after using the Fault Wizard. 
 
To avoid the possibility of electrical shock, always remember to turn off the Fault 
Wizard (Power toggle switch) before connecting or disconnecting the cables or 
handling the clips. 
 
High voltage output is from the Red clip.  Keep all clips connected to a cable under 
test, the cable cleats or to each other.  High voltage can be present at the red clip 
and you should always maintain knowledge of all three clips positions and 
connections.  Clip boots are for identification purposes only and are NOT rated for 
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high voltage.  DO NOT AT ANY TIME attempt to handle the clips or boots while 
the Fault Wizard is ON. 
 
Before closing the lid, turn the Power toggle switch to off, turn the Voltage knob to 
zero, and turn the Mode knob to HV TDR.  Please clip all three clips to the cable 
cleats to insure the HV output (red clip) is shorted to HV return (black clip) and 
chassis ground (green clip). 
 
Inform everybody in the area to avoid body contact with earthed or grounded 
surfaces such as pipes, transformers, fences, cables, equipment (including the Fault 
Wizard), etc. to avoid the possibility of electrical shock from step (ground return) 
currents.  For the operator, wearing the mandatory high-voltage electrical gloves 
while operating the unit will also eliminates this risk.  Keep children and bystanders 
away while operating this device. 
 
Do not expose the Fault Wizard to rain or wet conditions.  Water entering or 
pooling on the unit increases the risk of electric shock or equipment damage. 
 
The Fault Wizard contains high-energy capacitors, electrical shock is possible even 
if the Fault Wizard is unplugged and off!  Only qualified personnel should attempt 
to repair the Fault Wizard!  If service is required, return the unit to the factory 
only.  No field serviceable parts are inside the unit.  Danger of electrical shock exists 
if removed from the case.  See return information located elsewhere in this Owner’s 
Manual. 
 
To reduce the possibility of electrical shock, always make sure the Fault Wizard is 
unplugged and turned off while cleaning (see Maintenance Section).  
 Fault Wizard specifications- 
 
Output Voltage   0-10,000 Volts 
Output Current   12.5mA for Hi-pot Mode 
Output Energy    350 Joules (Max.) 
Input Voltage    24 VDC (internal batteries or 24 VDC Input Port) 
Input Voltage for battery charger 100-240 VAC 
Input Frequency for battery charger 50-60 Hz 
Input Current for battery charger 0.80 - 0.35A 
Weight     24 kg (53 lbs.) 
Size     25.4 x 45.7 x 48.3 cm (10” x 18” x 19”) 
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Introduction 
 
Congratulations on your purchase of the Fault Wizard primary cable fault locator.  The 
Fault Wizard requires no user assembly and is ready for setup and operation.  Some of the 
significant qualities of the Fault Wizard in comparison to all other Arc-Reflection 
(TDR/thumper) fault location systems are its relatively small size, low weight, and ease 
of operation.  These qualities make it easy to hand carry to the needed location for quick 
and precise fault location.   Due to the automated nature of the Fault Wizard, training for 
its operation is quick and easy. 
 
The basic method behind any Arc-Reflection system is to produce an arc at the fault 
location of a de-energized cable and to bounce a TDR pulse off of the arc in order to 
calculate how far down the cable the fault is located. 
 
The Fault Wizard is designed to thump through multiple transformers on a de-energized 
circuit where a fault has occurred.  You may thump from the open point, switchgear, or 
an overhead riser.  Since the Fault Wizard will give you the distance to the fault location, 
you will be able to quickly identify and isolate the faulted cable between two 
transformers, thus restoring service quickly.  After the cable has been isolated, the Hi-Pot 
Mode can be used to test the isolated cable to confirm (before re-closure) that the cable 
contains the fault.  Even though the Fault Wizard is compact and lightweight it still 
delivers almost as large a pulse of energy as many thumpers associated with TDR 
systems.  The discharge delivered at the cable fault can be heard above ground with 
common listening devices used by the electrical utility industry and heard quite often with 
just your own ears.  This gives the Fault Wizard a stand-alone capability when 
pinpointing the location of a fault after the faults general location has been determined.  
The Cycle Mode of operation allows repeated thumping (every six seconds at full 
voltage) for pinpointing the fault. 
 
 Setup 
 
Initial Inspection 
 
Each Fault Wizard has been inspected for its quality of construction and operation.  If you 
have any problems with your Fault Wizard, please refer to the Repair and Warranty 
sections in this manual. 
 
Operating Conditions 
 
Although the Fault Wizard is battery operated, it requires access to 100-240 VAC 
electrical power for battery recharging.  Always place the Fault Wizard on a flat stable 
surface.  The Fault Wizard will operate properly over normally encountered temperature 
ranges.  Restrain your Fault Wizard while it is in your vehicle to prevent it from 
sliding into hard objects or being bounced around.  The Fault Wizard is constructed to 
be durable, although, excessively rough handling can damage it and voids the warranty. 
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Wet Environment 
 
Although the Fault Wizard is designed to be internally shielded from the outside 
environment, the Fault Wizard is not “water proof”.  You should think of the Fault 
Wizard as being “splash resistant”.  Minimum exposure of the Fault Wizard to a wet 
environment is highly recommended.  If your Fault Wizard is exposed to a wet 
environment, then dry the Fault Wizard completely with a towel as soon as possible.  The 
cables should be unwrapped from the lid and completely dried.  DO NOT just shut the lid 
with wet cables and panel because the water will pool on the panel and greatly increase 
the chance of water entering into the unit.  Failure of the unit because of water damage 
voids the warranty! 
 
Caution -   Although the Fault Wizard is designed to be internally shielded from the outside 
environment, to avoid the possibility of electrical shock, never expose the Fault Wizard 
to a wet environment. 
 
Grounding Instructions   
 
For most electrical products, grounding provides a path of least resistance to prevent the 
possibility of electrical shock.  The Fault Wizard is provided with a copper braid 
"grounding cord" attached to an alligator clip connector (green) at one end and the Fault 
Wizard's internal metal frame at the other end.  The alligator clip connector must be 
connected to a solid and stable ground before the Fault Wizard is turned on.  All local 
codes and ordinances should be followed when grounding the Fault Wizard. 
 
Caution -   Improper grounding of the Fault Wizard can result in the risk of electrical shock and 
improper operation of the instrument!  Check with a qualified electrician if you are in 
doubt as to whether a power source or grounding object is properly grounded. 
 
 Operation 
 
The Fault Wizard is operated from the panel of the instrument.  There are two cables, two 
knobs, six buttons, a toggle switch, three receptacles, and a LCD display on the Fault 
Wizard.  Each of these will be discussed in detail below. 
 
Cables 
 
The HV Output cable provides the output for both the high voltage and the TDR pulses.  
The ground cable is used to ground the internal frame of the Fault Wizard to an external 
ground.  An alligator clip (green) is provided at the end of the ground cable.  The ground 
cable must be clipped to a well-grounded object before connecting the HV Output 
cable or before the Fault Wizard is turned on.  Attached to the end of the HV Output 
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cable is two alligator clips with rubber boots over the clips.  The clip with the red boot 
should only be attached to the center conductor of the power cable under test.  The 
clip with the black boot should only be attached to the concentric neutrals of the 
power cable under test.  For ease of storage and use, the cables should be held together 
when wrapping them around the cable cleats inside the lid and all three clips should be 
clipped to the cleats. 
 
Warning-   To avoid the possibility of electrical shock, always remember to turn off the Fault Wizard 
before connecting or disconnecting the cables. 
 
Power Switch 
 
The Power toggle switch is used to turn on the main power to the instrument.  Turning the 
Power switch off returns the Fault Wizard to a safe mode.  In order to conserve the 
energy stored in the batteries, turn the Power switch off when the Fault Wizard is not in 
use. 
 
Knobs 
 
The Voltage knob adjusts the HV power supply voltage (0-10 kV).  The Mode knob 
selects the Fault Wizard's operating mode.  There are three modes of operation: (1) HV 
TDR, (2) Cycle, and (3) Hi-Pot.  It is safe practice to turn the Voltage knob to zero 
after you are finished using the instrument or before changing into Hi-Pot Mode.   
HV TDR Mode 
 
The Fault Wizard is used in HV TDR Mode to activate the automated Arc-Reflection 
system in order to determine the distance to the fault.  By pressing the HV Start button in 
HV TDR Mode, the HV capacitor in the Fault Wizard is charged to the value set by the 
Voltage adjust knob.  Next, by pressing the Thump button, the energy stored in the HV 
capacitor is discharged into the cable under test while the TDR system is simultaneously 
activated.  In addition, the Fault Wizard is returned to an unenergized state.  Press the 
Stop/Ground button at any time to stop the test and return the instrument to an 
unenergized state. 
 
Cycle Mode 
 
The Fault Wizard is used in Cycle mode (with listening equipment) to pinpoint a fault.  
By pressing the HV Start button in Cycle mode, the Fault Wizard starts to charge and 
discharge in a cyclic fashion.  The Voltage knob setting, with a maximum of 6 seconds at 
full voltage, determines the cycle time.  If the cable under test does not break down from 
a discharge at any time during cycle thumping, the cycle will stop.  However, the 
capacitor will still be at the set charge voltage.  If this occurs, either increase the voltage 
setting on the Voltage adjust knob until the cable breaks down and cycle thumping 
resumes or press the Stop/Ground button.  Press the Stop/Ground button at any time to 
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stop the cycle thumping and return the instrument to an unenergized state.  The energy of 
the pulse delivered to the power cable is dependent on the charge voltage of the internal 
capacitor when the Fault Wizard is discharged.  Energy of 350 J is stored when the 
capacitor is charged to 10 kV. 
 
Hi-Pot Mode 
 
The Fault Wizard is primarily used in Hi-Pot mode to confirm that an isolated section of 
cable actually has the fault.  By pressing the HV Start button in Hi-Pot mode, the DC 
output voltage will try to rise to the voltage set by the Voltage Adjust knob.  Therefore, 
good practice is to set the Voltage Adjust knob to zero before pressing the Start button.  
The hold-off voltage of the cable can be determined by raising the DC output voltage 
gradually by use of the Voltage Adjust knob.  The voltage displayed by the LCD meter 
will not rise above the breakdown voltage of the cable.  You will usually see a sudden 
drop in voltage on the meter when the cable breakdown voltage is reached.  When 
desired, press the Stop/Ground button to stop the test and return the instrument to an un-
energized state. 
 
Buttons 
 
HV Start 
 
The green HV Start button turns on the HV power supply and illuminates the red LED on 
the control panel.  In HV TDR Mode or Cycle Mode, the capacitor is charged to the 
voltage level set by the Voltage adjust knob.  In Hi-Pot Mode, the DC output voltage tries 
to rise to the voltage set by the Voltage adjust knob. (Note: for newer models, a “Zero 
Start” feature has been added.  The Voltage knob must be set to zero before the HV 
Start button is enabled.)  
Thump 
 
In HV TDR Mode, the yellow Thump button fires the Fault Wizard (HV discharge 
coupled with a TDR pulse).  The Fault Wizard is then returned to an unenergized state. 
 
Stop/Ground 
 
The red Stop/Ground button turns off the HV power supply and internally grounds the 
HV capacitor through a dump resistor and internally grounds the output (red booted) lead.  
The red LED also ceases to illuminate.  In addition, holding the Stop/Ground button 
down for three seconds changes the LCD Display to the following: 
 STORE WAVEFORM IN MEMORY CANCEL-GO TO MAIN SCREEN  
Pressing the Stop/Ground button a second time chooses the selection made and returns 
the LCD Display to the Main screen. 
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Cable Vp (Up and Down) 
 
The two Cable Vp buttons (Up and Down) are used to change the velocity of propagation 
(Vp) setting for the cable under test.  In addition, the Up and Down buttons are used to 
scroll through the selections in the Store Waveform In Memory mode. 
 
LV TDR 
 
The green LV TDR button is used to fire a low-voltage TDR pulse down the cable 
(without a HV discharge) to determine the distance to an open (often used to determine 
the full length of the cable under test). The LV TDR button is deactivated when the HV 
power supply is on (red LED illuminated). 
 
Data Port 
 
The Data Port receptacle is used to download waveform data to a computer by utilization 
of the Fault Wizard Software.  The receptacle is a standard 9-pin D-Subminiature 
connector.  A compatible communication cable is provided with the Fault Wizard. 
 
Battery Charger 
 
The Fault Wizard uses two 12 VDC, 8.5 AH rechargeable lead-acid batteries.  On a full 
charge they should allow the Fault Wizard to be charged and discharged hundreds of 
times before recharging is required.  The battery voltage is displayed on the meter.  When 
the voltage reads below 22 volts for more than 3 seconds, the battery voltage will flash on 
the LCD Display.  The batteries will need to be recharged soon.  Charging is 
accomplished using a standard equipment power cord (supplied) and a single-phase 100-
240 VAC power outlet.  While charging the batteries, the battery voltage on the LCD 
Display will slowly increase.  The Fault Wizard does NOT need to be on to charge the 
batteries.  Fully recharging completely depleted batteries takes about 6 hours.  Recharging 
the batteries for long periods of time does not hurt the batteries.  In order to protect the 
battery charger, the Fault Wizard should not be operated while charging the 
batteries.  A 24 VDC output auxiliary Battery Pack or 24 VDC output AC Pack can be 
purchased to allow continued field use if the batteries run low or fail.  Eventually, the 
internal batteries, like all batteries, will fail and you will have to send your Fault Wizard 
back to our Repair Center for replacement of the batteries (see Maintenance section).  
(Note: for newer models, the Battery Charger is mounted inside the lid between the 
cable cleats.  A cord with a connector at the end runs from the Battery Charger to 
the input port on the panel.  The AC input receptacle for the Battery Charger is 
mounted on the outside on top of the lid by the handle).  
Lead Acid Batteries 
 
As mentioned earlier, the Fault Wizard uses two internal sealed lead-acid batteries.  
Unlike Ni-Cad batteries, lead-acid batteries DO NOT like to be deep discharged.  Deep 
discharging the batteries will decrease the energy storage capacity and life of the batteries.  
To avoid deep discharging the batteries, do not continue to operate the Fault Wizard after 
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the battery voltage begins flashing on the LCD Display.  At this point, the batteries need 
to be recharged or an external 24 VDC source (Battery or AC Pack) needs to be utilized.  
Innovative Utility Products Corp. highly recommends purchasing one of the auxiliary 
packs if the Fault Wizard is going to be used for cycle thumping.  In addition, if the Fault 
Wizard power is left on for an extended period of time and the batteries completely 
discharge, the batteries will die and quite often cannot be recharged.  If the batteries are 
dead, plugging in the Fault Wizard to recharge the batteries will not accomplish 
recharging the batteries.  For this situation, the battery voltage on the LCD Display will 
show about 28 volts because the batteries have “opened up” and are not drawing current, 
therefore, not pulling the charger voltage down.  By the way, batteries are not covered 
by the warranty!  Remember to turn off the power to your Fault Wizard when you 
are finished to avoid killing your batteries! 
 
24 VDC Input 
 
The Aux. 24 VDC Input receptacle is used to provide 24 DC auxiliary power to the Fault 
Wizard.  A compatible power cord is provided with the purchase of the auxiliary Battery 
Pack or AC Pack. 
 
LCD Display 
 
On power up, the LCD Display shows the following: 
 STARTUP DIAGNOSTIC TEST RESULT: PASS  
The result should be PASS.  If the result is FAIL, a message stating to contact the factory 
is shown.  The LCD Display then momentarily shows the following: 
 TDR Version 8.4.2  
or what ever version number your Fault Wizard contains at present time.  The LCD 
Display then shows momentarily the following: 
 NORMAL CABLE IMPEDANCE SELECTED  
or possibly LOW instead of NORMAL, depending on the last setting used.  The 
difference in the two settings will be discussed at the end of this section.  Display then 
shows momentarily the following: 
 15FTCL  
or possibly 40FTCL, depending on whether your Fault Wizard has long cable leads or 
short cable leads.  Finally, the LCD Display shows the Main Screen, which looks similar 
to the following: 
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CV:00.0KV  BV:24.2V RD:?????F  RT:??  VP.513  
where CV, BV, RD, RT, and VP indicate the HV power supply’s charge voltage, battery 
voltage, reflection distance, reflection type, and velocity of propagation setting, 
respectively. 
 
For typical Arc-Reflection scenarios (HV TDR), the reflection distance (RD) displayed 
should be the distance to the fault (arc) and the reflection type (RT) should show SH for 
short (since an arc looks like a short to the TDR system).  For resistive arc conditions (not 
flashing from center to outer conductor), RT will show a blinking RF indicating a 
resistive fault and RD will give the distance to the open point when operating in Normal 
Cable Impedance mode.  Under Low Cable Impedance mode, HV TDR always tries to 
yield the distance to the arc or short.  If the condition is a pre-short or resistive, then RT 
will show a blinking SH.  LV TDR always looks for an open point and RT always shows 
OP.  The velocity of propagation (VP) is the fraction of the speed of light the signal 
travels up and down the cable.  Typical values for power cables will range between .4 and 
.6.  Refer to the list of Vp values for various cable types found in Table 1 later in this 
Manual. 
 
Calibration of the Vp for any specific cable type can easily be accomplished by use of the 
LV TDR function on a length (spool) of cable if the length of cable is known.  Hook up 
the HV Output cable as described above in the Cables section.  Next, turn on the Power 
switch to the Fault Wizard.  Now, press the LV TDR button.  As you can see on the LCD 
Display, you should get a value for the reflection distance (RD).  Next, press the Up or 
Down button for the Cable Vp until the reflection distance shows the value of the length 
of cable under test.  The value of the velocity of propagation setting (VP) is the Vp value 
for that type of cable.  You should note that no high voltage was ever applied to the cable 
under test. 
 
Waveform Storage 
 
Holding down the Stop/Ground button for three seconds changes the LCD Display to the 
following:  We will refer to this screen as the beginning screen. 
 STORE WAVEFORM IN MEMORY CANCEL-GO TO MAIN SCREEN  
Pressing the Up button changes the display to read the following: 
 MEMORY NUMBERS 01 TO 08  
Pressing the up button again changes the display above to the same but with 09 to 16.  
Since eight waveforms are stored each time the TDR system is activated (Thump or LV 
TDR), you can select between 01 to 08, 09 to 16, …, and 105 to 112.  Therefore, you can 
store fourteen activations (eight waveforms per activation) of the TDR system.  
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You can also press the Down button to move backwards.  For example, in order to get to 
the CLEAR ALL MEMORY NUMBERS screen from the beginning screen, just push the 
Down button once.  The LCD Display will show the following: 
 CLEAR ALL MEMORY NUMBERS  
Pressing the down button one more time changes the display to read the following: 
 SWITCH TO LOW CABLE IMPEDANCE  
Pressing the down button one more time changes the display to read the following: 
 SWITCH UNITS TO METERS  
Pressing the down button one more time changes the display to read the following: 
 MEMORY NUMBERS 105 TO 112  
In order to select any screen and go back to the Main Screen, press the Stop/Ground 
button once.  In order to NOT select anything and go back to the Main Screen, 
make sure you are on the following screen and press the Stop/Ground button.  STORE WAVEFORM IN MEMORY CANCEL-GO TO MAIN SCREEN  
Assuming that you chose to store the next group of waveforms in the first eight memory 
slots, the Main screen will look something like the following: 
 CV:00.0KV  BV:24.2V  M01 RD:?????F  RT:??  VP.513  
As you can see, the M01 was added to the screen to indicate that the Fault Wizard is 
armed for waveform storage in the first four non-volatile memory slots.  As soon as the 
TDR system is activated, the M01 will disappear.  Non-volatile memory means that the 
waveforms will not be erased if you turn off the Fault Wizard.  The only way to erase the 
memory slots is to choose the CLEAR ALL MEMORY NUMBERS selection.  
Therefore, selection of any one of the fourteen memory groups (eight waveforms per 
group) will display one of the following: M01, M09, …, or M105. 
 
Most of the time, you will want to operate the Fault Wizard under the NORMAL CABLE 
IMPEDANCE mode.  However, for some cable types such as “mining cable” and “feeder 
cable” (such as 750 or 1000 MCM), the LOW CABLE IMPEDANCE mode will work 
better.  Low impedance cable attenuates the waveforms to the point that this special mode 
of operation is sometimes necessary. 
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Test Procedure   
 
Faulted Cable Section Isolation 
 
1. Open the top of the Fault Wizard case in order to gain access to the control panel. 
 
2. Ground the Fault Wizard as described in the Setup section in this manual. 
 
3. Connect the Fault Wizard to the de-energized cable as shown in Figure 1.  The red 

alligator clip attaches to the center conductor and the black clip to the concentric 
neutrals.  The case ground should be connected to the system neutral.  Note:  The 
cable you are connecting the Fault Wizard to should be tested for voltage to insure 
the cable is de-energized. 

 
Warning -    
High voltage output is from the Red clip.  Keep all clips connected to a cable under 
test, the cable cleats or to each other.  High voltage can be present at the red clip 
and you should always maintain knowledge of all three clips positions and 
connections.  Figure 1 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
4. Turn on the power to the Fault Wizard. 
 
5. If the battery voltage is low (<22 volts) an auxiliary pack can be used.  The Fault 

Wizard batteries should be charged as soon as possible.   
 

HV Cable 
Grounding Cord 

System Ground Bus 
Green 

Insulation 
Red 

Black 

Center Conductor 

Semicon 

Concentric 
Neutrals 
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6. Set the Mode knob to HV TDR.  
 
7 Turn the Voltage knob to “Zero” 
 
8. Press the HV Start button. 
 
9. Set the Voltage knob to at least 7 kV.  Although a good starting voltage for the 

charge voltage, you may require higher voltage settings to get consistent readings. 
 
10. Press the Thump button on the Fault Wizard to discharge the Fault Wizard into the 

test cable.  Note:  The sound you here inside the Fault Wizard when you press the 
thump button can tell you important information about the system under test.  Refer 
to the “Helpful Facts” section for more information. 

 
11. Wait for the Fault Wizard to display the distance to the fault. 
 
12. Repeat steps 7 through 11 to see the consistency in the results.  You may want to 

adjust the Fault Wizard's discharge voltage to obtain consistent Fault Wizard 
readings.  The more consistent the readings are, the more confident you will be on 
the accuracy of the distance to the fault. 

 
13.  Based on the fault distance reading from the Fault Wizard, isolate the section of 

cable that contains the fault.  You may want to confirm that the isolated section of 
cable is actually faulted by use of the Fault Wizard's Hi-Pot mode.  This is described 
in steps 14 through 22.  Note: You can only use the Hi-Pot mode on isolated sections 
of cable not connected to any transformers. 

 
Verifying Isolated Cable Section Is Faulted 
 
14. Connect the Fault Wizard to the isolated cable to test. 
 
15. Turn on the power to the Fault Wizard. 
 
16. Turn the Voltage knob to zero. 
 
17. Set the Mode knob to Hi-Pot mode. 
 
18. Press the Start button. 
 
19. Turn the Voltage knob to raise the voltage on the cable. 
 
20. Note the hold-off voltage of the cable. 
 
21. Press the Stop/Ground button to stop the test. 
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22. If the cable held-off the full 10 kV of voltage, then you probably have isolated an un-
faulted section of cable.  Therefore, isolate and hi-pot the closest sections of cable to 
determine which one contains the fault. 

 
Fault Pinpointing on Isolated Cable Section  
 
1. Follow steps 1 through 5 above. 
 
2. Turn the Voltage Adjust knob to zero. 
 
3. Set the Mode knob to Hi-Pot mode.  Note: you can only use the Hi-Pot mode on 

isolated sections of cable not connected to any transformers. 
 
4. Press the HV Start button. 
 
5. Turn the Voltage knob to raise the voltage on the cable. 
 
6. Note the hold-off voltage of the cable. 
 
7. Press the Stop/Ground button to stop the test. 
 
8. Set the Mode knob to HV TDR. 
 
9. Turn the Voltage knob to “Zero” 
 
10. Press the Start button. 
 
11. Set the Voltage knob to at least 7 kV.  Although a good starting voltage for the 

charge voltage, you may require higher voltage settings to get consistent readings. 
 
12. Press the Thump button on the Fault Wizard to discharge the Fault Wizard into the 

test cable.  Note:  The sound you here inside the Fault Wizard when you press the 
thump button can tell you important information about the system under test.  Refer 
to the “Helpful Facts” section for more information.  

 
13. Wait for the Fault Wizard to display the distance to the fault. 
 
14. Repeat steps 9 through 13 to see the consistency in the results.  You may want to 

adjust the Fault Wizard's charge voltage to obtain consistent Fault Wizard readings.  
The more consistent the readings are, the more confident you will be on the accuracy 
of the distance to the fault. 

 
15. Set the Fault Wizard mode to Cycle mode.   
 
16. Turn the Voltage knob to “Zero” 
 
17. Press the Start button. 
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18. Set the Voltage knob to at least 7 kV (note: loudest sound at the fault is produced at 

10 kV) 
 
19. While the Fault Wizard is cycle thumping, go to the general location of the fault by 

measuring off the distance determined by the Fault Wizard to the fault. 
 
20. By using proper listening equipment, you should be able to pinpoint the fault 

location.  
 

Helpful Facts 
 This section has been included to help you better utilize your Fault Wizard locating 

system. 
 
1. The Fault Wizard must produce an arc at the fault from the center conductor to the 

concentric neutrals before it can obtain the distance to the arc (fault).  However, 
some cable failures may involve arcing to earth and/or semicon.  Like all arc-
reflection systems, the Fault Wizard can’t "lock in" on the distance to the fault for 
these situations.  Increasing the charge (discharge) voltage may help produce an arc 
from the center conductor to the concentric neutrals. 

 
2.  Listening to the internal thump sound the Fault Wizard makes in HV TDR mode is 

very important.  If there is a fault and the cable arcs from the center conductor to the 
neutrals (metal to metal) when the thump button is pressed, you should hear a solid 
“whack” sound from the Fault Wizard, itself.  We refer to this situation as “hitting 
hard”.  This is because the energy is quickly rushing out of the unit.  If there is not a 
fault or a resistive fault (arc to semi-con or dirt or gaps in the neutrals from 
corrosion), you will not hear the “whack” sound but a “dull” sound or just a clicking 
sound of the internal relay.  We refer to this situation as “hitting soft”.  Note: unless 
you hear the “whack” sound in HV TDR (hitting hard), you will not get the correct 
distance reading. 

 
3. Some cable failures may involve open-fault scenarios such as pull-apart splices or 

the center conductor burning apart.  Under these circumstances, using the low 
voltage TDR feature of the Fault Wizard will give the distance to the fault.  
Thumping the cable under HV TDR mode will confirm the fault distance for the 
situation of the center conductor having burned apart. 

 
4.  If the fault is within 20 to 30 feet of the Fault Wizard, it is difficult for the Fault 

Wizard to see the fault distance.  This is true for all arc-reflection systems.  On the 
display (RD), you should get all question marks.  However, on rare occasion, you 
might get a false distance out a few hundred feet.  If this occurs, then test from the 
other end. 



 

© Copyright 1999 by Innovative Utility Products Corp.           17                                                                   Rev. 1.11 

Maintenance 
 
The internal lead-acid batteries will eventually have to be replaced.  Therefore, you will 
eventually have to send your Fault Wizard back to our Repair Center for replacement of 
the batteries.  If you want to replace the internal batteries yourself, please call Innovative 
Utility Products Corp. for guidance (see Repair section). 
 
Calibration 
 
Your Fault Wizard was calibrated during the manufacturing process. It can be sent back 
to our Repair Center for calibration (see Repair section). 
 
Cleaning 
 
The Fault Wizard can be cleaned externally with a damp (not wet) rag containing a mild 
solution of soap and water or a typical household glass cleaner. 
 
Do not use harsh cleaning solutions, such as organic solvents (e.g., acetone), that may 
mar the surfaces.  Like most electrical items, do not immerse the Fault Wizard in any type 
of liquid. 
 
Warning-   In order to avoid the possibility of electrical shock, always make sure the Fault Wizard is 
unplugged and turned off while cleaning it! 
 
Warning -  
NEVER operate or turn on the Fault Wizard without the Red clip connected to a cable 
under test or the cable cleats.  High voltage can be present when unit is on and Class I or 
better High Voltage rated gloves must be worn whenever handling the Red clip. 
 
 Repair 

 
Your Fault Wizard can be sent back to our Repair Center for repair.  Before sending it 
back, please call our Repair Center at (479) 410-2098 for shipping instructions.  If you 
decide to repair or modify your Fault Wizard by any other means than shipping it to our 
Repair Center, Innovative Utility Products Corp. assumes no liability for injury (or death) 
resulting from your Fault Wizard.  In addition, any attempt to repair or modify your Fault 
Wizard (without IUP approval) voids the warranty. 
 
Warning-   Since the Fault Wizard contains high-voltage capacitors, electrical shock is possible even 
if the Fault Wizard is unplugged!  Only qualified personnel should attempt to repair the 
Fault Wizard. 
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Warranty 
 
Innovative Utility Products Corporation (IUP) warrants its products to be free from 
defects in material and workmanship under normal and proper use for a period of one 
year from date of shipment from IUP's factory. Any products purchased from IUP that 
upon inspection at IUP's factory prove to be defective will be repaired (at IUP's option) 
without charge. This limited warranty shall be void in regard to (1) any product or part 
without IUP's previous written consent or (2) any product or part thereof that has been 
subjected to unusual electrical, physical or mechanical stress or upon which the original 
identification marks have been removed or altered. Transportation charges for shipping 
any product or part thereof that the buyer claims is covered by this limited warranty shall 
be paid by the buyer.  With the express warranty set out above, IUP does not grant any 
warranties either expressed or implied, including implied warranties of merchantability or 
fitness for use.  
 
The obligations or liabilities of IUP specifically shall not be liable for damages, IUP 
specifically shall not be liable for reinstalling any product or part thereof repaired or 
replaced under the limited warranty set out above. IUP expressly excludes all liability for 
any indirect or consequential damages the buyer may sustain in connection with the 
delivery, use, or performance of IUP's products. 
  
Under no circumstances shall any liability for which IUP is held responsible exceed the 
selling price to the buyer of IUP's products that are proven to be defective. This limited 
warranty applies exclusively to IUP's manufactured products. Any legal action for breach 
of any IUP warranty must be commenced within one year of the date on which the breach 
is or should have been discovered. 
 
 Technical Support 
 
Innovative Utility Products Corporation believes in providing technical support in order 
for you to best utilize the Fault Wizard.  In order to serve the needs of our customers we 
welcome all comments and suggestions regarding the Fault Wizard.   Technical Support 
can be reached at (479) 410-2098.   Technical Support's Fax number is (479) 410-3260. 
 
 Specifications 

 
Max Charge Voltage: 10 kV 
Max Hi-Pot Voltage: 10 kV 
Max Energy Storage: 350 Joules 
Max Cycle Time: 6 seconds for 10 kV charge 
Weight: 24 kg (53 lbs.) 
Size:  25.4 cm x 45.7 cm x 48.3 cm (10" x 18" x 19") 
Battery Capacity:  8.5 AH at 24 V 
Battery Charger Input Voltage: 100-240 VAC, 50/60 Hz, single phase 
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Table 1 
 
Typical velocity of propagation values that can be used if needed.  Values may vary 
depending on the number of transformers and splices in the circuit.  If you are not sure, 
then try using a velocity of propagation that is about .520. 

 
 KV Class Mils Cable Size  Type  Vp 

 15  175 #1CU   XLPE  .554 
15      175 #2AL   XLPE  .495 
15  175 #2CU   XLPE  .514 
15      175 #4CU   XLPE  .516 
15  175 1/0   XLPE  .522 
15  175 1/0   TRXLPE .510 
15      175 2/0   XLPE  .486 
15  175 4/0   XLPE  .472 
15      175 500MCM  XLPE  .526 
15  175 750MCM  XLPE  .536 
15  175 1000MCM  TRXLPE .430 
15      175 #2AL   EPR  .544 
15  175 1/0   EPR  .508 
15      175 4/0   EPR  .572 
15  220 1/0AL   TRXLPE .550 
25  260 1/0AL   TRXLPE .540 
25  260 1/0AL (CU Ribbon) TRXLPE .570 
35  345 1/0   XLPE  .565 
--  --- 2/0 Mining Trailing ---  .430 
--  --- 4/0 MPF  ---  .540 
--  --- 2/0 MPF  ---  .520 
--  --- 2/0 GGC Round ---  .500 
--  --- #2 GGC Round ---  .540 
--  --- #4 -4/c W Round ---  .530 
--  --- Pilot Wireless Avg. ---  .600 
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Fault Wizard Software 
 
Installation 
 
1. Insert the Fault Wizard Software CD into your CD Drive on your computer. 
 
2. Open the CD and run Setup.exe. 
 
3. Follow the on-screen instructions provided by the installation software. 
 
4. For uninstalling the Fault Wizard Software from your computer, follow steps 1-3.  

At a specific window provided to you, you can select to remove the software. 
 
5. Hook up the computer cable (provided) from the Fault Wizard’s Data Port to your 

computer’s com port (com 1-5).  If your computer does not have a com port but 
does have a USB port, you can use the Fault Wizard Software but you will need to 
buy a USB to serial cable (which you should be able to find on the internet or 
possibly from a local computer store). 

 
Using the Fault Wizard Software 
 
Turn on the Power (toggle) switch on your Fault Wizard.  Open the Fault Wizard 
Software by double clicking on the icon.  The following graph window is displayed. 
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Next, choose the Graph Size submenu under the Settings menu with your mouse. A 
dialog box will appear.  Choose the settings that make your graph fit your computer 
screen the best.  Now, choose the Communications Port submenu under the Settings 
menu. A dialog box will appear.  Choose the computer port that you want to use.  The 
most common problem encountered during the attempt to download waveforms from the 
Fault Wizard is communication between your computer and the Fault Wizard.  If such a 
problem occurs, make sure that you have selected the proper port.  In addition, if some 
other application on your computer has been using that port, then that application may not 
have released it for use by the Fault Wizard Software.  A remedy of the problem is to 
open that application and have that application chose a different port.  You may (not 
always) have to reboot your computer for the port selection to take affect.  If you want to 
change the graph titles for your graph, then select the Graph Titles submenu under the 
Settings menu.  You can change the three titles displayed on your graph.  If you want no 
titles, then replace each title with a space.  Choose Retrieve Waveform from FW 
submenu under the File menu. The following dialog box will appear. 
 

  
Select which waveform color you want to use.  You can display four waveforms at the 
same time by loading a waveform into each color slot.  You can only load one waveform 
at a time.  In other words, you will see this dialog box four times before you have four 
waveforms loaded.  By selecting OK, the following dialog box will appear. 
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Eight waveforms are stored in the Fault Wizard’s volatile memory each time the HV 
TDR system is activated (four waveforms are stored for LV TDR with the remaining four 
left blank).  The bottom entry box is used to retrieve any one of these eight waveforms 
from the Fault Wizard’s volatile memory.  Since these waveforms are stored in volatile 
memory, they are lost in the Fault Wizard if the Fault Wizard is turned off.  The 
waveforms that are stored in the Fault Wizard’s non-volatile memory (retrieved using the 
top entry box) remain in the Fault Wizard until the Clear FW Memory submenu under 
the File menu is selected or cleared from the Fault Wizard itself.  Turning off the Fault 
Wizard does NOT remove these waveforms from the Fault Wizard’s memory.  By the 
way, the Fault Wizard must be on in order for your computer to communicate with the 
Fault Wizard.  After entering an appropriate number in one of the two entry boxes, the 
graph window will be updated to look like something shown below. 
 

  
As you can see, a green waveform is shown in the graph.  You should also note that two 
vertical red lines (cursors) appear in the graph and the values for the Distance Between 
Cursors and Velocity of Propagation shown at the bottom of the graph have changed.  
The Velocity of Propagation (Vp) is stored in the waveform data and is displayed for the 
first waveform loaded into the graph.  The position of the alligator clips is represented by 
the left cursor.  The position of the open point (for LV TDR) or the arc (for HV TDR) is 
represented by the right cursor.  The distance between these two cursor lines based on the 
given Vp is displayed for the first waveform loaded into the graph.  Loading additional 
waveforms into the graph does not change the position of the cursors or the Vp. 
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You can hide the Distance Between Cursors and the Velocity of Propagation displayed at 
the bottom of the graph by selecting the Show Distance & Vp submenu under the View 
menu.  To show it again, reselect it. 
 
You can change the position of the cursors by clicking on the graph with the left mouse 
button (for left cursor) or the right mouse button (for right cursor).  Changing the cursor 
positions does change the distance displayed.  You can change the value of the Vp and 
the units (feet or meters) used for distance by selecting the Vp & Units submenu under 
the Settings menu.  You can reset the cursor positions or the Vp based on the values 
stored in any of the loaded waveforms by selecting the Reset Cursors or Reset Vp 
submenu under the Settings menu, respectively. 
 
To hide the green waveform shown in the graph, select the Green Waveform submenu 
under the View menu.  To show it again, reselect it.  If waveforms are loaded for the 
other colors, you can hide or display them by choosing the Purple Waveform, Blue 
Waveform, and Red Waveform submenus under the View menu. 
 
To zoom in on part of the waveform, select the Zoom In submenu under the View menu.  
Next, click and hold your left mouse button while you drag your mouse.  A blue rectangle 
will appear in the drag area.  The area within the rectangle will be the area of the graph 
redisplayed.  For example, the previous graph is redrawn as shown below. 
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You can actually zoom in multiple times.  Therefore, you can return to the previous graph 
displayed by selecting the Previous View submenu under the View menu.  You can 
return the graph to the un-zoomed view by selecting the Full Size submenu under the 
View menu. 
 
You can save any loaded waveform to a file by selecting the Save Waveform to Data 
File submenu under the File menu.  The data is saved as a file with the Fault Wizard Data 
file extension (.fwd).  You can reload any saved file by selecting the Open Waveform 
from Data File submenu under the File menu. 
 
You can also print the displayed graph by selecting the Print submenu under the File 
menu.  By selecting the Page Setup submenu under the File menu, you can choose 
different printer options. 
 
To see what version of software you are currently using, select the About Fault Wizard 
Software submenu under the Help menu.  To quit the program, select the Exit submenu 
under the File menu or click the close box located in the top right corner of the graph 
window. 
 
Understanding Waveforms 
 
Each activation of the TDR system (LV TDR or HV TDR) produces multiple 
waveforms..  Each waveform is unique.  There are three different TDR output pulse 
widths (narrow, medium, and wide).  The four waveforms produced by the LV TDR are 
the following: (1) narrow, (2) medium, (3) wide, and (4) wide looked at with higher 
amplitude resolution.  The eight waveforms produced by the HV TDR are the following: 
(1-4) same as the four LV TDR waveforms, (5) narrow during the arc, (6) medium during 
the arc, (7) wide during the arc, and (8) wide during the arc looked at with higher 
amplitude resolution.  The 2nd and 5th waveforms from a HV TDR activation are the 
medium pulse widths before the arc and during the arc, respectively.  The data was taken 
from a 105 ft power cable.  The end of the cable was flashed for this HV TDR data.  
Now, by zooming in on the waveform data, you get the graph below. 
 
As you can see in the graph, there is a large positive output pulse followed by the “up & 
down” reflection of the alligator clips (both green and purple waveforms).  The left red 
cursor is positioned in the center of the alligator clip reflection.  Next, you see a positive 
reflection (green waveform) from the open point at the end of the cable and a negative 
reflection (purple waveform) from the arc at the end of the cable.  The right red cursor is 
positioned at the end of the cable.  The remaining part of the graph shows “oscillations” 
from the reflections.  If the cable had actually been flashed in the middle of the cable 
instead of at the end, the negative reflection from the arc would have been closer to the 
alligator clip reflection than the open point reflection. 
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Battery Pack 
 
An auxiliary Battery Pack can be purchased for use with the Fault Wizard.  The Battery 
Pack is highly recommended for several reasons.  The Battery Pack is a great “backup” in 
case the Fault Wizard’s internal batteries become depleted of energy or if the batteries 
fail.  Also, lead-acid batteries DO NOT like to be deep discharged.  When the Fault 
Wizard’s internal batteries become depleted, the battery voltage (BV) on the display will 
blink.  Although continued operation can be performed, the result is deep discharging of 
the internal batteries.  This can decrease the life and energy storage capacity of the 
internal batteries.  The Battery Pack gives the user an alternative to continuing the use of 
the internal batteries after the battery voltage (BV) on the display begins to blink.  The 
Battery Pack consists of the following components: (1) grey polycarbonate Battery Box 
with chrome handle and black connector port, (2) black Battery Charger with 115 VAC 
equipment cord, and (3) grey Hookup Cord with black connector at each end. 
 

  
Using the Battery Box with the Fault Wizard 
 
To use the Battery Pack with the Fault Wizard, connect one end of the grey Hookup Cord 
to the connector port on the Battery Box and the other end to the 24 VDC Input port on 
the Fault Wizard panel.  If the battery voltage from the Battery Box is greater than the 
battery voltage from the internal batteries in the Fault Wizard, then the battery voltage 
(BV) on the display will go up when you connect the two.  If the battery voltage (BV) on 
the display is blinking, then you need to turn the Fault Wizard’s power off and then back 
on to reset the unit so the battery voltage (BV) will not blink.  The Fault Wizard’s internal 
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batteries and the batteries in the Battery Box can not “back feed” each other.  In other 
words, the energy from each will only flow to the Fault Wizard.  Therefore, you can not 
use the charger that comes with the Battery Pack to charge the Fault Wizard’s internal 
batteries.  Likewise, plugging the 120 VAC equipment cord into the Battery Charger port 
on the Fault Wizard’s panel while the Battery Box is connected to the Fault Wizard will 
not charge the batteries in the Battery Box.  However, it will obviously charge the internal 
batteries in the Fault Wizard. 
 
Charging the Batteries in the Battery Box 
 
The batteries in the Battery Box are charged using the Battery Charger and 120 VAC 
equipment cord that came with the Battery Pack.  Plug the 120 VAC equipment cord into 
the Battery Charger and a 120 VAC outlet.  Actually, the input voltage to the Battery 
Charger can be 100-240 VAC, 50-60 Hz, single-phase (see back of Battery Charger).  The 
green “power” LED on the Battery Charger will illuminate to indicate it has power.  Next, 
plug the connector from the Battery Charger to the connector port on the Battery Box.  
The yellow “charge” LED on the Battery Charger will illuminate to indicate that charging 
of the batteries is occurring.  When the batteries are fully charged, the charger goes into 
“trickle mode” and the yellow LED turns off indicating that your batteries are fully 
charged.  It does not hurt the batteries to leave them hooked up to the Battery Charger 
after the batteries are fully charged.  It takes about 6 hours to fully charge depleted 
batteries.  If the yellow “charge” LED on the Battery Charger does NOT turn off 
after about 8 hours of charging your Battery Box, then please disconnect the 
charger from the Battery Box and replace your batteries.  There is a possibility of 
an internal short in one of the batteries and overheating of the Battery Box and 
Battery Charger can occur.  The Battery Charger does not have enough power to power 
the Fault Wizard.  DO NOT connect the Battery Charger to the 24 VDC Input port 
on the Fault Wizard’s panel or damage to both devices may occur and voids the 
warranty. 
 
Replacing the Batteries in the Battery Box 
 
It is quite easy to replace the batteries in your Battery Box.  Unscrew the four plastic bolts 
from the four top corners of the Battery Box lid with a large flathead screwdriver.  The 
four plastic bolts remain in the lid.  Lift the lid off of the Battery Box.  The picture below 
shows the inside of the Battery Box. 
 
Next, remove the four “quick connect” connectors from the batteries’ terminals by pulling 
on the connectors (not the wires!).  The use of needle-nose pliers makes removing and 
attaching the connectors quite easy.  You can now remove and replace the batteries.  After 
you are finished replacing the batteries, reconnect the connectors to the terminals.  Place 
the lid back onto the Battery Box and tighten the four plastic screws at the four corners of 
the lid. 
 
Note: Tucked away in the front right corner of the Battery Box is an inline fuse holder 
attached to the red wires.  The fuse holder contains an 8 amp slow-blow fuse.  If the 
Battery Box does not output voltage, then check the fuse to see if it has been blown.  If it 
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has been blown, then check the wiring (including the wires attached to the back of the 
output port) to see if an electrical short has occurred. 
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AC Pack 
 
The use of the Fault Wizard AC Pack is quite straightforward.  Use the grey cable with 
connectors on both ends to attach the AC Pack to the 24 Volt Input on the Panel of the 
Fault Wizard.  The Equipment Cord is used to plug the AC Pack to an electrical outlet.  
The AC Pack accepts 100-240 VAC, 50-60 Hz. 
 

  
Caution-   The Fault Wizard and AC Pack will heat up during normal use.  This especially occurs 
during cycle thumping.  Therefore, the Fault Wizard and AC Pack should not be operated 
for more than 1 hour continuously in cycle mode.  It is important to allow the Fault 
Wizard and AC Pack time to cool down (about 1 hour) after 1 hour of continuous use in 
cycle mode.  If you do not, the Fault Wizard and AC Pack can be damaged.  Overheating 
of the Fault Wizard and AC Pack voids the warranty. 


